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CHAPTER 1

Ovarview

Antelope is a collection of software which implements the acquisition, distribution
and archive of environmental monitoring data and processing. It provides both
automated real time data processing, and offline batch mode and interactive data
processing. Major parts of both the real time tools and the offline tools are built on
top of the Datascope relational database system. This tutorial explains some basic
concepts behind relational database systems and how these concepts appear in
Datascope.

Datascope: What isit?

Datascopeis arelational database system in which tables are represented by fixed-
format files. These files are plain ASCI| files; the fields are separated by spaces and
each lineisarecord. The format of the files making up a database is specified in a
separate schemafile. The system includes simple ways of doing the standard opera-
tions on relational database tables: subsets, joins, and sorts. The keysin tables may
be simple or compound. Views are easily generated. |ndexes are generated automat-
icaly to perform joins. General expressions may be evaluated, and can be used as
the basis of sorts, joins, and subsets.

The system provides a variety of ways to use the data. There are ¢, FORTRAN,
tcl/tk and perl interfaces to the database routines. There are command line utilities
which provide most of the facilities available through the programming libraries.
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Overview

There are afew GUI toolsfor editing and exploring a database. And, since the data
istypically plain ASCII, it's also possible to just use standard UNIX tools like sed,
awk, and vi.

Datascope: Features
e Datascopeis small, conceptually smple, and fast.

» Datascope hasinterfaces to several languages (c, FORTRAN, tcl/tk, perl and
MATLAB), acommand line interface, and GUI interfaces. These provide a
wide range of access methods into databases.

* Datascope does not provide access through a specialized query language, such
as SQL.

» Datascope provides most of the features of other commercial database systems,
including:

* dataindependence
* schema independence
* view generation through joins, subsets, sorts, and groups

* automatic table locking to prevent database corruption when multiple users
are adding recordsto atable

e The organization of tables and fields within a Datascope database is specified
with a plain text schemafile. This schemafile, in addition to specifying the
fields which make up tables, and the format of individual recordsin every table,
provides agreat deal of additiona information, including:

* short and long descriptions of every attribute and relation
* null values for each attribute

* alega range for each attribute

e units for an attribute

* primary and alternate keys for relations.

e foreign keysin arelation

This additional information is useful for documenting a database, and makesit easier
for anewcomer to learn a new database.
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¢ The detailed schema often makes it possible to form the natural joins between
tables without explicitly specifying the join conditions.

» Datascope schema files and database tables are stored in normal ASCII files on
the UNIX file system. These files can be viewed and edited using normal text

editors (although it isinadvisable to hand edit database tables). File access per-
missions are controlled through the normal UNIX file permissions.

* Thekeysin Datascope tables may include ranges, like a beginning and an end-
ing time. Thisis useful, and sometimes essential, for time dependent parame-
ters, like instrument settings. Indexes may be formed on these ranges, and these
indexes can considerably speed join operations. (When two tables are joined by
time range keys, the join condition is that the time ranges overlap.)

* Datascope has an embedded expression calculator which can be used to form
joins, sorts and subsets. This calculator contains many functions which are
peculiar to environmental science applications, such as spherical geometry,
exhaustive time conversion functions and seismic travel time functions.

Datascope: What isit good for ?

Relational database systems are a proven method for representing certain types of
information, much more powerful than the traditional grab-bag approach of data
files, log files, handwritten notes, and ad hoc data formats. Datascope is a general-
purpose relational database management system which isideal for managing the
large and complex data volumes that are produced by a modern environmental
monitoring network. It isrelatively easy and intuitive when compared to other com-
mercial database products. It provides away of moving from the traditional pleth-
ora of formats to a better approach which organizes the data, documentsit, and
provides powerful tools for manipulating it.

Datascope should be useful to anyone who needs to organize data and is interested
in applying relational database technology, but can’t afford the time, learning,
development, and peopl e resources which most other commercial database systems
require.
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CHAPTER 2

Ted Drive

L earning a database system such as Datascope takes some time and involves at least
the following steps:

* |earning about relational databasesin general
¢ learning the tools and operations a particular DBMS provides
¢ learning a particular database schema

¢ learning a particular database

This chapter gives awhirlwind tour of a small example database, using the general
purpose Datascope tool dbe. Thiswill get your feet wet, show you quickly how to

do avariety of useful things, and get you started learning about relational databases
in general, and Datascope in particular.

Datascope was originally developed for seismic applications and the demo database
has seismic data. It contains data recorded at seismic stations around the world and
parameter data describing those instruments (location, gains, orientation). Thisis
the “raw data’ part of the database. In addition, the database contains information
which is derived from the raw data, typically information about earthquakes: loca-
tion, size, and first arrivals of seismic energy from various earthquakes at the vari-
ous stations.
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Test Drive

What isarelational database?

A database can be any collection of information, hopefully organized in some fash-
ion that makesit easy to find a particular piece of information. Relational databases
organize the data into multiple tables. Each table is made up of records, and each
record has a fixed set of fields (sometime referred to as “attributes’). The structure
of adatabase, i.e. the tables and the fields which make up arecord, is called the
schema. The schemafor our demo is a variation of a schema developed at the Cen-
ter for Seismic Studies.

A standard reference text for databasesis “An Introduction to Database Systems”,
by C.J. Date. Start with it if you would like to learn more about relational databases
in particular.

dbe: awindow on a database

dbeisagenera purposetool for exploring, examining, and editing arelational data-
base. It providesin asingle interactive, graphical tool most of the functionality pro-
vided by Datascope. Because it is window and menu driven, it isfairly easy to
learn. This discussion will lead you through a session with dbe, but probably the
best way to learn it isto explore on your own. Follow along with this discussion by
running dbe on the demo database that comes with the Antelope distribution and is
normally installed in /opt/antel ope/data/db/demo.

Begin in an empty directory where you can write files, and start dbe:

% dbe /opt/ant el ope/ dat a/ db/ deno/ demo

This brings up a database window with multiple buttons, one for each table of the
demo database.

—
I /opt/antelope/data/db/demo/demo

File Options Help

affiliatiun' arri\ral' assm:' instrument' Iastid' nEtmagI netwurkl urigin' sensur' siteI sitechan stamag' widisc
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Viewing atable

Press the button labeled wfdisc. This brings up a new spreadsheet-like window on

the wfdisc table.
I Jopt/antelope/sdata/sd b/demo/demowfdisc

File Edit ¥iew Options Graphics Process Help

ok|x] Tel~

0 sta chanI time | endtime | nsamp | samprate

[l |—————— ) 21:55:15.200 | 5/17/1992 (138) 21:57:21.500 | 2527 | 20.0000000
cin | channel P 7hjs is an eight-character code, which, taken together 20.0000000
E:gz aAdd expression with sta, jdate and time, uniquely identifies the source ggggggggg
T || @ o of t:n_e ISE|§m|t|:'|:1.ata, |nc|ud|ngdthe zengrapl:l: Itncatlnn, 0, T
EKS2 | pelete column spatial orientation, sensor and subsequent data 200000000
USP | Find Forward HHOEESSTITH 20.0000000
YSP | Find Backward 20.0000000
USP | o value Null: - 20.
TEH Sort ¥ 21:55:19.050 571771992 (138) 21:57:35.950 2739 | 20.0000000
TRH o ) 21:55:19.050 5/17/1992 (138) 21:57:35.950 2739 | 20.0000000
TEH Subset ) 21:55:19.050 5/17/1992 (138) 21:57:35.950 2739 | 20.0000000
KBK |EHZ 5/17/1992 (138) 21:55:14.400 5/17/1392 (138) 21:57:18.450 2482 | 20.0000000
KBK |EHN 5/17/1992 (138) 21:55:14.400 5/17/1992 (138) 21:57:18.450 2482 | 20.0000000
KBK |BHE 5/17/1992 (138) 21:55:14.400 5/17/1992 (138) 21:57:18.450 2482 | 20.0000000
AAK  |BHZ 5/17/1992 (138) 21:55:10.250 5/17/1992 (138) 21:57:02.650 2249 | 20.0000000
AAK  |EHN 5/17/1992 (138) 21:55:10.250 5/17/1992 (138) 21:57:02.650 2249 | 20.0000000

7 |AAK  |BHE 5/17/1992 (138) 21:55:10.250 5/17/1992 (138) 21:57:02.650 2249 | 20.0000000

181 |

Dismiss

The window title is the name of the table. Beneath it is amenu bar, and directly
beneath that is atext entry area. Thisentry areais used both for directly editing
fields, and for various operations which require text input, like entering an expres-
sion or searching for aparticular value.

The main portion of the window has a column for each field, up to the limit of what
will fit on the screen. The scrollbar on the left controls the range of records dis-
played, while the scrollbar on the bottom may be used to scroll by column, and
show the columns which didn’t fit on the screen.

At the top of each column isacolumn header button showing the field name. These
buttons bring up menus which allow several column specific operationslike sorting,
searching, or editing.

Viewing schema information

One entry of the header button shows detail information about field. Thereissimilar
information about the table under the Help->On wfdisc far right menu of the
menubar. For even more information about the schema, try the Help->On Schema
option; this brings up awindow with buttons for each table:
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Test Drive

= dbhelp:css3.0 2
Schema: ¢s553.0
Path:  .Hdemo}
Center for Seismic Studies Schema Version 3.0
Modifications from ariginal C55 documentation N
1) Mull values corrected for certain attributes
) ofidate added to primary keys for tables in which it occurs
3) endtime added to primary keys for tables in which it occurs.
4 time made first primary key in origin far soring.
5) arid and orid added to foreign keys in assoc
) mace range values expression for automated testing
T) added wiedit relation 12/3/93
) changed the primary key in sitechan to chanid, and added
chanid a5 a foreign key in sensor to force joins
of sitechan to go through sensor table
9) changed primary keys in moment and centryd tahle to orid
10) added calibration and stage tables 1/31/34
11) changed primary keys in stamag to arid, magtype, sta, orid
12) changed primary key in site to sta (no ondate, offdate)
13) changed null values for orger’s covariant matrix
14) changed definition of ndef for origing included from other catalogs
15) added beam, fkgrid and stgrid tahles to accomodate array processing
12/15/94
16) added witar table to accomodate tar tape waveform archiving 1/3/35 v
achanaux |affiliation |anetsta |arrival assoc | beam calibration |centryd dmcseed | dmowf
emodel event fkgrid fplane gregion | instrument | lastid moment |netmag ||network
origerr origin predarr | predmech |remark |schanloc seedformat ||seedindex|sensor |site
sitechan |snetsta specdisc |sregion stage stamag stassoc stgrid widisc |wfedit
Jwfmeas |wfrms wftag witape wftar
Search for. Dismiss

Each table button brings up awindow describing that table, showing the keys and
other information from the schema. And they contain buttons for each field of the
table. Press the wfdisc button, bringing up the window for the wfdisc table.

— widisc ‘
Waveform file header and descriptive information

[This relation provides a pointer {or index) to waveforms

stored on disk. The waveforms themselves are stored in

ordinary disk flles called widisc orw files, containing

only a sequence of sample values (usually in binary

representation)

Primary key: sta chan time:endtime

Alternate key: wfid

Defines id: wfid

Foreign keys: commid chanid

Record Size (bytes): 284

Records: 18

Size (bytes): 5112

Permissions: read—only

File: Fopt/antelopefdatafdb/demo/demo.widisc

sta chan |time wfid chanid ”jdatE ||En|:|time ”nsan

samprate calib |calper |instype segtype”datatype |||:Iip ”dir
Jdfile foff |commid |Iddate

Dismiss
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Press afield button to bring up a window showing information about afield. The
row of table buttons at the bottom shows each table which uses this field.

) .
— wfdisc.samprate | 0 |J|
sampling rate in samplesisec

This attribute is the sample rate in samples/second. In

the instrument relation this is specifically the nominal

sample rate, not accounting far clock drit. In widise,

the value may wary slightly from the nominal o reflect

clock drift.

Field type: REAL
# characters: 11
First character 88
printf format: %11.71f
Null value; -1.0000000
Range: samprate > 0.0
Units: 1/seconds
Used in tables:
_‘dmcwf Hinstrument ”stage ”wfdisc watape ”wftarl
Dismiss

This adjunct to dbe is also available as a separate program, dbhelp.

Performingajoin

Refer back to the help window for the wfdisc table; this table describes external
fileswhich contain recorded data from an instrument. The sta and chan fields spec-
ify aparticular location and instrument. These fields, plus the time and endtime
fields, al taken together, comprise the primary key for the wfdisc table. This means
that for a particular station, channel and time range, there should be just one row in
the wfdisc table.

This relates to a very fundamental idea behind relational databases: a particular
piece of information resides in only one place. If it needs to be corrected, it need
only change in one place. Contrast this with atypical situation where a correction
may require updates in many locations; finding all the locations can be amajor
problem.

The wfdisc table provides areference to the data for a particular instrument at a spe-
cific time and location. Notice that a considerable amount of information is miss-
ing: where on the globe was this data recorded? That information is not contained
in the wfdisc table; instead it is kept in another table, the site table. Find the original
dbe database window, and press the button labeled site (or use the menu File-
>QOpen Table->site).
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Test Drive

~\ Jopt/antelope/data/db/demo/demo.site \ . \J\
File Edit ¥iew Options Graphics Help
k| x] [«[»
0 sta | ondate lat lon eley | staname statype| refsta| dnorth deast

X [HIA 1986201 49.2667 | 119.7417 0.6100 |[Hailar, Meimenggu Province, China
KIV 1988258 43.9562 42 6888 1.2100 |Kislovodsk, Russia

KHI 1986159 25.1233 || 102.7400 1.9450 (Kunming, Yunnan Province, china
LSA 1991333 29.7000 91.1500 3.7890 |Tibet, china

LZH 1986151 36.0867 | 102.8444 1.5600 |Lanzhou, Gansu Province, China
OBN 1988258 55.1138 36.5687 0.1600 |Obninsk, Russia

Wus 1988305 41.1990 79.2180 1.4570 |Wushi, Xinjiang Uygur, China

CHH 1991244 42.9986 74.7513 0.6550 |Chunmysh, Kyrgyzstan ss AAK 40.6512 20.8922
EKS2 | 1991244 42.6615 73.7772 1.3600 |Erkin-Sai, Kyrgyzstan 55 AAK 3.3841 | -58.6444
usp 1991244 43.2669 74.4997 0.7400 |Uspenovka, Kyrgyzstan 55 AAK 70.4529 0.4293
TEH 1991244 42 . 8601 75.3184 0.9600 |Tokmak, Kyrgyzstan ss AAK 25.5465 67.1613
KBK 1991244 42.6564 74.9478 1.7600 |Karagaibulak, Kyrgyzstan 55 AAK 2.6678 37.0771
7 |AAK 1991244 42.6333 74.4944 1.6800 |Ala-archa, Kyrgyzstan 55 AAK
I EL= 1
Dismiss

In thistable, you can find the location at which a particular piece of datawas
recorded: |atitude, longitude, and elevation. If the original elevation was measured
incorrectly, it can be corrected here, in just one place. Thisis an important strength
of relational databases, but it is also a problem: the data about location is not kept
with the recorded datawhereit is most convenient during processing. Instead, when
you need the location, you must look it up in the site table.

Looking up information in the site table is simplified by arelational operation
called ajoin. This means creating a new composite table composed of columns
from other tables. In this particular case, we want to join wfdisc with site. Go back
to the wfdisc window, and under the view menu, select “join->site”. The wfdisc
window disappears, and a new window appears. Thiswindow containsaview into a
table which isthe join of wfdisc with site.

What about the join conditions?

Conceptually, the join operation may be viewed as combining every row of the first
table with every row of the second table, but only keeping combinations which sat-
isfy some condition. For this particular join, the condition to be satisfied is: station
ids match, and the time range of the wfdisc row matches (overlaps) the time range
of the site row. In most RDBM S (Relational DataBase Management Systems), you
would need to specify this condition explicitly, but Datascope is able to infer and
provide the join condition in many cases. The chapter on Basic Datascope Opera-
tions describes how this is accomplished.
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File Edit ¥iew Options Graphics Process

pt/antelop

sta ||:han time endtime nsamp | samprate ondate lat lon

CHM  |EHZ 5/17/1992 (138) 21:55:15.200 5/17/1992 (138) 21:57:21.500 2527 | 20.0000000 | 1991244 42,9986 74.7513 0.

CHH  |BHN 5/17/1992 (138) 21:55:15.200 5/17/1992 (138) 21:57:21.500 2527 | 20.0000000 | 1991244 42,9986 74.7513 0.

CHH  |EHE 5/17/1992 (138) 21:55:15.200 5/17/1992 (138) 21:57:21.500 2527 | 20.0000000 | 1991244 42.9986 74.7513 0.
EKSZ |BHZ 5/17/1992 (138) 21:55:04.700 5/17/1992 (138) 21:56:41.550 1938 | 20.0000000 | 1991244 42.6615 73.7772 1.
EKS2 |BHN 5/17/1992 (138) 21:55:04.700 5/17/1992 (138) 21:56:41.550 1938 | 20.0000000 | 1991244 42.6615 73.7772 1.
EKS2 |BHE 5/17/1992 (138) 21:55:04.700 5/17/1392 (138) 21:56:41.550 1938 | 20.0000000 | 1991244 42.6615 73.7772 1.

USP  |EHZ 5/17/1992 (138) 21:55:15.700 5/17/1992 (138) 21:57:23.350 2554 | 20.0000000 | 1991244 43.2669 74.4997 0.

USP  |BHN 5/17/1992 (138) 21:55:15.700 5/17/1992 (138) 21:57:23.350 2554 | 20.0000000 | 1991244 43.2669 74.4957 0.

USP  |EHE 5/17/1992 (138) 21:55:15.700 5/17/1392 (138) 21:57:23.350 2554 | 20.0000000 | 1991244 43.2669 74.4997 0.

TEM  |EHZ 5/17/1992 (138) 21:55:19.050 5/17/1992 (138) 21:57:35.950 2739 | 20.0000000 | 1991244 42,8601 75.3184 0.

TEH  |BHN 5/17/1992 (138) 21:55:19.050 5/17/1992 (138) 21:57:35.950 2739 | 20.0000000 | 1991244 42,8601 75.3184 0.

TEH  |EHE 5/17/1992 (138) 21:55:19.050 5/17/1992 (138) 21:57:35.950 2739 | 20.0000000 | 1991244 42.8601 75.3184 0.

KEK |EHZ 5/17/1992 (138) 21:55:14.400 5/17/1992 (138) 21:57:18.450 2482 | 20.0000000 | 1991244 42,6564 74.9478 1.

KBK |BHN 5/17/1992 (138) 21:55:14.400 5/17/1992 (138) 21:57:18.450 2482 | 20.0000000 | 1991244 42,6564 74.9478 1.

KBK |EHE 5/17/1992 (138) 21:55:14.400 5/17/1392 (138) 21:57:18.450 2482 | 20.0000000 | 1991244 42.6564 74.9478 1.

AAK  |BHZ 5/17/1992 (138) 21:55:10.250 5/17/1992 (138) 21:57:02.650 2249 | 20.0000000 | 1991244 42.6333 74.4944 1.6800
AAK |BHN 5/17/1992 (138) 21:55:10.250 5/17/1992 (138) 21:57:02.650 2249 | 20.0000000 | 1991244 42.6333 74.4944 1.6800
AAK  |BHE 5/17/1992 (138) 21:55:10.250 5/17/1992 (138) 21:57:02.650 2249 | 20.0000000 | 1991244 42.6333 74.4944 1.6800
= T =

Dismiss

Arranging fieldsin a window

dbe chooses some order in which to display the fields of aview. This order may be
inconvenient. To obtain amore useful layout, select the View->Arrange menu.

~—| Display order | - | |
all | none
1 W sta - site.sta
2 W chan 7 W opndate
3 M time -1 offdate
A wfid 8 W |at
i chanid 9 W lon
- jdate 10 & glev
4 W endtime 11 @ staname
5 W nsamp 12 W statype
6 W samprate 13 ™ refsta
- calib 14 ® dnorth
_i calper 15 W deast
- instype - site.lddate
- segtype
I datatype
A clip
1 dir
4 dfile
- foff
- commid
| i lddate
cancel I ok

Datascope: A Tutorial
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Test Drive

The Arrange option brings up a dialog window in which you may select the col-
umns you wish to display, and the order in which they’ |l appear. Press the none but-
ton, then select the fields you want, and finally press ok.

~\ Jopt/antelope/data/db/demo/demoViewds \ . \J\
File Edit ¥iew Options Graphics Process Help
ot el=
0 sta ||:han lat lon elev staname

= [cim |[gHZ 42.9986 74.7513 0.6550 (Chumysh, Kyrgyzstan

CHM |BHN 42.9986 74.7513 0.6550 |Chumysh, Kyrgyzstan

CHH  |EHE 42.9986 74.7513 0.6550 (Chumysh, Kyrgyzstan

EKS2 |BHZ 42.6615 73.7772 1.3600 |Erkin-Sai, Kyrayzstan

EKS2 |BHN 42.6615 73.7772 1.3600 |Erkin-Sai, Kyrgyzstan

EKS2 |BHE 42.6615 73.7772 1.3600 |Erkin-Sai, Kyrgyzstan

USP  |EHZ 43.2669 74.4997 0.7400 |Uspenovka, Kyrayzstan

USP  |BHN 43.2669 74.4997 0.7400 |Uspenovka, Kyrgyzstan

USP  |EHE 43.2669 74.4997 0.7400 |Uspenovka, Kyrgyzstan

TRH  |EHZ 42.8601 75.3184 0.9600 |Tokmak, Kyrayzstan

TKM |BHN 42.8601 75.3184 0.9600 |Tokmak, Kyrgyzstan

TEH  |EHE 42.8601 75.3184 0.9600 |Tokmak, Kyrgyzstan

KBK |EHZ 42.6564 74.9478 1.7600 |Karagaibulak, Kyrgyzstan

KBK |EHN 42.6564 74.9478 1.7600 |Karagaibulak, Kyrgyzstan

KBK |EHE 426564 74.9478 1.7600 |Karagaibulak, Kyrgyzstan

AAK  |BHZ 42.6333 74.4944 1.6800 |#la-Archa, Kyrayzstan

ASK  |BHN 42.6333 74.4944 1.6800 |Ala-Archa, Kyrgyzstan

7 |AAK  |BHE 42.6333 74.4944 1.6800 |#la-Archa, Kyrgyzstan
184 1

Dismiss

Viewing datain arecord view

dbe normally presents datain a spreadsheet form, but sometimes it’s difficult to see
al theinformation on asingleline. An alternative isto view the data one record at a
time. Therecord view shows all the fields in the order in which they appear in the
tables which make up the view. Click the right mouse button over the row which
you want to seein arecord view to bring up a new window. You can adjust the
record either by clicking again on a different row, or by using the scrollbar on the
left. Bring up multiple windows with shift-right-mouse.
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~\ Jopt/antelope/data/db/demo/demoViewd 7 \ . \J\
File Edlt ¥iew Options Process Help
add| ok| [«[~>
AAK 571771992 (138) 21:55:10.250 15887 1992138
1 sta time wid chanld jdate
5/17/1992 (138) 21:57:02.650 2249 20.0000000 1.195355 0.000000
endtime nsamp samprate calib calper
RefTek s2 uf/knetc/1992/138/210426 19921382155.10.AAK. BHN
instype |[segtype ||datatype dir dfile foff
1/18/1995 (018) 21:43:33.000 AAK 1991244 42.6333 74.4944
commid Iddate site.sta ondate offdate lat lon
1.6800 Ala-Archa, Kyrgyzstan 55 AAK
eley staname statype |[refsta dnorth deast
8/11/1993 (223) 0:00:00.000
site.lddate
Dismiss

Other database operations

Thejoin operation is probably the most difficult operation on arelational database.
Other operations are simplein comparison. You can sort atable, using alist of fields
or expressions. You can extract the subset of the records in a table which satisfy
some conditions. You can combine these operations, performing a subset, then a
join, then a sort, for example. We'll try some of these operations now.

Select View->Sort in the menubar of the joined table. This brings up adialog win-
dow like the arrange dialog. Select some keys (maybe, sta, chan, time) for sorting,
press done, and the table will be sorted, bringing up a new window. Notice the
unique option, similar to the unix sort -u option. When you want to sort by only a
single column, you can use the sort menu entry under the column as a short cut.

You can sort according to an expression as follows:

1. enter di st ance(43. 25, 76. 949997, | at, | on) into the entry window.
2. select add expression under the staname column header.
3. anew column Expr should appear; select Expr->sort under this column.

These are the stations sorted by distance from Alma Ata:

Datascope: A Tutorial
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Jopt/antelope/data/db/demo/demo.Views 3

File Edit ¥iew Options Graphics Process Help
_IJdistance(43.25,75.343357,Iat,|nn) [«[»
0 sta ||:han lat lon elev staname Expr
IS [Tkm |[BHE 42.8601 75.3184 0.9600 |Tokmak, Kyrayzstan 1.2543164408
TEH |BHZ 42.8601 75.3184 0.9600 |Tokmak, Kyrgyzstan 1.2543164408
TEH |EHN 42.8601 75.3184 0.9600 |Tokmak, Kyrgyzstan 1.2543164408
KBK |EHE 42.6564 74.9478 1.7600 |Karagaibulak, Kyrgyzstan 1.5810353087
KBK |EHN 42.6564 74.9478 1.7600 |Karagaibulak, Kyrgyzstan 1.5810353087
KBK |EHZ 426564 74.9478 1.7600 |Karagaibulak, Kyrgyzstan 1.5810353087
CHH  |EHZ 42.9986 74.7513 0.6550 (Chumysh, Kyrgyzstan 1.6242907986
CHH  |BHE 42.9986 74.7513 0.8550 |Chumysh, Kyrgyzstan 1.6242907986
CHH  |EHN 42.9986 74.7513 0.6550 (Chumysh, Kyrgyzstan 1.6242907986
USP  |EHZ 43.2669 74.4997 0.7400 |Uspenovka, Kyrayzstan 1.7844937143
USP  |BHN 43.2669 74.4997 0.7400 |Uspenovka, Kyrgyzstan 1.7844937143
USP  |EHE 43.2669 74.4997 0.7400 |Uspenovka, Kyrgyzstan 1.7844937143
AAK  |EHN 42.6333 74.4944 1.6800 |#la-Archa, Kyrayzstan 1.9003671058
AAK  |BHZ 42.6333 74.4944 1.6800 |Ala-Archa, Kyrgyzstan 1.9003671058
AAK  |BHE 42.6333 74.4944 1.6800 |#la-Archa, Kyrgyzstan 1.9003671058
EKS2 |EHE 42.6615 73.7772 1.3600 |Erkin-Sai, Kyrayzstan 2.3953504793
EKS2 |BHZ 42.6615 73.7772 1.3600 |Erkin-Sai, Kyrgyzstan 2.3953504793
7 |[EKS2 |BHN 42.6615 73.7772 1.3600 |Erkin-Sai, Kyrgyzstan 2.3953504793
184 1
Dismiss

You can use the | eft scrollbar to scroll to a particular record. However, this may be
inconvenient in alargetable. Asan alternative, try typing the station name (USP, for
example) into the entry window, then click on one of the arrows to the right of th e
entry window. This should move amatching record up to the top row of the display.
You can alternatively type control-return or control-backspace, or use the find for-

ward and find backwards menu options.

The simplest search just looks for a matching string in the entire record. However,
you can enter a Datascope expression like chan =~ /.*Z/, or just aregular expres-
sion. A search with an empty expression advances one page.

Creating a subset view

Subset views are created by specifying a Datascope expression; only records which
satisfy the expression are kept in the view. Asasimple example, enter st a==" KBK”
into the entry window, and then select View->subset.

14
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~| Jopt/antelope/data/db/demo/demo.Views s \ . \J\

File Edit ¥iew Options Graphics Process Help
_IJ I Q—I -
0 sta Il:han lat lon elev staname Expr

S[KeK  |EHE 42.6564 | 74.9478 1.7600 |Karagaibulak, Kyrgyzstan 1.58103530878
KEK |BHN 42,6564 | 74.9478 1.7600 |Karagaibulak, Kyrgyzstan 1.58103530878
7 |kEK  |BHZ 42.6564 | 74.9478 1.7600 |Karagaibulak, Kyrgyzstan 1.58103530878
I3 T

Dismiss

The original window disappears, and a new window with just the selected station
appears. By default, dbe eliminates the old window after operations like join, sort
and subset. This avoids cluttering the screen. However, you can keep the old win-
dow by selecting the Options->keep window menu.

For both searching and subsetting, you can look for records that satisfy more com-
plex criteria-- liketi me > “1992138 21: 50" && chan == “BHZ".The
syntax of Datascope expressionsis similar to ¢ and FORTRAN, and is covered in
detail in alater chapter.

Using dbunjoin to create a subset database

There are anumber of editing operations you can perform, but not on this demo
database, which has been made read-only. Permissions are controlled strictly with
standard UNIX permissions, so you can probably override this. Instead, let’s create
asmall local database that you can edit.

You already have aview of a subsetted join of wfdisc and site, and you have subset-
ted this table to contain only station KBK. Now join this table successively with
sensor, sitechan, and instrument. These tables make up the core tables of the data
side of the CSS database. The join you create references only rows which relate to
the station KBK. Select File-> Save.. on the menu. Select to new database, and enter
nmydeno as the name. Press the Save button.

Datascope: A Tutorial 15
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" "
= Save to file [
% to new Database

~ Plain Text

~ Text separated by tabs

w View

Database Name

Save Cancel

|mydemo

A new database is created in your current directory named mydeno. It has copies
of each relevant row of the original database.

%Is
nmydeno nmydeno. sensor nmydeno. si t echan
nydeno. i nst runent nydeno. site nydeno. wf di sc

Editing a database

You now have a copy of the database which you can edit. Open this database, either
by running dbe against it, or by using the “File->Open Database..” menu.

= mydemo [
File Options Help
| instrument| sensor| site| sitechan| wfdisc

Bring up awindow on the site table by pressing the site button. Thiswindow should
have just one record: there was just a single station in the view from which you cre-
ated this database.

Before you can edit this table, you must select Options->Allow edits under the
Options menu. After that, you can select afield by clicking in it, then edit that field
inthe entry area. When you are satisfied, click on the ok, or click on another field to
edit. Scrolling will also save the edited value. For example, change the elevation
from 1.760 to 1.670.

You can change awhole column of values by entering an expression in the entry
area, and using the Set value menu option under the column header. For instance,
you could change all the dir fields in the wfdisc table from

16
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wi/knetc/1992/138/210426 to plain wf by first bringing up the wfdisc window, then
typing wWf in the entry area, and choosing the dir->Set value menu option. Alterna-
tively, you could get rid of the 138 directory in the path by putting patsub(dir,
“138/",“") inthe entry area, and choosing dir->Set value.

Note that these changes only change the table. The waveform files are actually still
back in the original directory, and the wfdisc table is wrong. This operation (actu-
aly an unjoin, described later) does not adjust references to external files. You
could correct thiswith asymbolic link, or by editing dir to make it /opt/ante-
|ope/data/db/demo/wi/knetc/1992/138/210426

Try creating a new dffiliation table, using the File->Create New Table->affiliation
menu in the main dbe menubar. This brings up a dialog window into which you
may type values, and then use add to add new records.

You can aso delete rows by selecting afew rows with the mouse, and then using
the Edit->Delete menu (this option will be disabled if you have not previously
selected Options-> Allow edits). For reasons which will become clear later, it's usu-
ally undesirable to physically remove the deleted records immediately. Instead,
each field of these deleted records s set to the corresponding null value; alater
crunch operation removes the null records.

Incidentally, multiple rows may be selected by dragging the mouse. Multiple selec-

tions are made by holding the shift key while clicking or dragging. However, mov-
ing or just clicking on the scrollbar clears all selections.

Simple graphing

dbe allows some simple graphing. Go back to the demo database, and bring up a
window on the origin table. Select Graphics->graph:
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Jopt/antelope/data/db/demo;

emo.origin

File Edit ¥iew Options graphicsI_Prucess Help
ok Graph_| [+
0 lat lon depth time mhb ms algorithm auth
g 40.0740 69.1640 || 155.1660 | 4/27/1992 (118) 10:51:40.669 2.62 Tocsat:kyrghyz |JSPC
36.9340 71.0010 0.0000 | 4/27/1992 (118) 18:02:36.212 3.72 locsat:kyrghyz (1SPC
37.8700 69.7160 | 248.0190 | 4/27/1992 (118) 20:02:08.274 2.27 Tocsat:kyrghyz |JSPC
5.6020 | 124.0540 || 477.0000 | 4/28/1992 (119) 1:55:47.200 5.50 PDE
8.7370 | 126.6880 || 440.7540 | 4/28/1992 (119) 1:55:49.326 5.45 locsat:kyrghyz (1SPC
41.7760 72.2910 4.4830 | 4/28/1992 (119) 6:40:35.579 2.45 Tocsat:kyrghyz |JSPC
42.7720 71.5250 || 225.5050 | 4/28/1992 (119) 7:17:54.714 1.44 Tocsat:kyrghyz |JSPC
38.5400 76.2530 33.0000 | 472871992 (119) 8:52:52.367 3.29 locsat:kyrghyz (1SPC
39.8610 75.8050 0.0000 | 4/28/1992 (119) 9:26:28.979 2.33 Tocsat:kyrghyz |JSPC
8.9210 | 124.0710 || 568.0000 | 4/28/1992 (119) 9:31:21.700 5.20 PDE
9.5440 | 123.8020 || 520.6560 | 4/28/1992 (119) 9:31:23.487 4.72 locsat:kyrghyz (1SPC
43.0250 74.9040 0.0000 | 4/28/1992 (119) 10:37:32.390 Tocsat:kyrghyz |JSPC
37.2890 69.8470 | 115.0000 | 4/28/1992 (119) 14:32:20.376 2.76 Tocsat:kyrghyz |JSPC
39.9120 79.0960 14.0000 | 472871992 (119) 15:53:53.000 4.00 less_reliable |PDE
40.3030 79.0230 36.2840 | 4/28/1992 (119) 15:53:59.245 3.55 Tocsat:kyrghyz |JSPC
-5.6310 | 133.7880 33.0000 | 4/28/1992 (119) 17:26:53.200 5.20 4.70 PDE
22.4300 98.9350 33.0000 | 472871992 (119) 21:03:03.600 4.60 4.70 PDE
25.9130 99.3710 10.4580 | 4/28/1992 (119) 21:03:23.549 4.26 Tocsat:kyrghyz |JSPC
43.3650 77.0060 19.2340 | 4/29/1992 (120) 5:35:09.077 2.90 Tocsat:kyrghyz |JSPC
39.7720 66.7010 0.0000 | 4/29/1992 (120) 5:42:55.791 3.92 locsat:kyrghyz (1SPC
43.3750 74.6750 5.7500 | 4/29/1992 (120) 6:25:33.569 Tocsat:kyrghyz |JSPC
42.6570 74.8570 8.6820 | 4/29/1992 (120) 9:02:06.223 Tocsat:kyrghyz |JSPC
39.9800 73.4700 0.0000 | 4/29/1992 (120) 10:14:49.787 2.90 locsat:kyrghyz (1SPC
27 .8680 51.2330 10.0000 | 4/29/1992 (120) 10:42:10.300 4.30 PDE
i 42.3040 75.1410 13,5290 | 4/29/1992 (120) 12:03:12.602 Tocsat:kyrghyz |JSPC
1351 )~ i
Dismiss

This brings up an empty graph. Enter | on and | at inthex andy entry areas,
either by typing or selecting from the menubutton label on the left of the entry area.
Then pressthe “plot” button. Press the menubutton labeled “ origin”, and select
“site”. Use the button to the right of the Subset entry area which has a plot symbol
in it to select a different plot symbol, color, and/or size. Press the “plot” button
again. The result should look something like:

18
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" "
= Graph origin [
100 o
. . :
50 | ‘ ) e
t. * -
.
E v ' R
0
—50
T T T T T T T T 1
—200 —100 0 100 200
lon
site Suhset:l 0| |
Title |
ﬂlnn _J.l LogScale
7ﬂlat u.l LogScale
Plot I Remove I Clear I I Legend Postscript Done

This graph shows all the origins (event locations or hypocenters) from the origin
table as small black diamonds, and all the station locations as slightly larger red
diamonds.

There are avariety of other ways to manipulate a graph; the best way to learnisto
play with this. You can select aregion of the graph by clicking the left mouse button
twice to delineate the interesting region, which will then be magnified. You can do
this multiple times; then clicking the right mouse will back out to the full view.

You can select subsets of the table by typing an expression in the Subset entry area,
and you can change the scalesto log scales. The plot can be saved as postscript,
yielding a higher resolution than the screendump above.

Summary

This short tour of the demo database has introduced the dbe interface, and shown
how to do ssimple joins, subsets, and sorts, as well as how to extract asmall data-
base from alarge database. By simply playing with the various menus and buttons,
you should now be able to form rather complex queries into the demo database.
However, you will probably find it helpful to read the later chapters to learn more

Datascope: A Tutorial
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about expressions and various database operations. dbe is probably the most useful
single tool in the Datascope stable, but there are a variety of other tools for special-
ized use, and the primary value of Datascope comesin its use in programs.

20
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CHAPTER 3

Schema and Data
Representation

Datascope keeps tables as plain ASCI| files. Each lineis a separate record, and the
fields occupy fixed positions within each line. (Thereis no variably sized text field.)
The name of afile which represents atableis composed of two parts -- the database
name and the table name, i.e. database.table. Typically, all the tables which make up
adatabase are kept in asingle directory. However, there is also provision to keep
certain tablesin a central location, but have multiple versions of other tablesin
other locations.

Database Descriptor Files

Datascope understands a descriptor file which specifies afew important parameters:
¢ the database schema name

e apath along which various tables of the database may be found.

¢ thetablelocking mechanism

* central id server

The schema name is used to look up a schemafile. Thisfileistypically kept in
$(ANTELOPE)/data/schemas, but may instead be kept in the directory with the

database descriptor -- this provides a means of testing alternative or modified sche-
mas prior to installing them centrally.

Datascope: A Tutorial
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The database path specifies a path along which to look for the files while hold the
database tables. For any particular table, thefirst file matching the table name found
along the path must contain the table.

The last two parameters are optional; they relate to table locking performed during
the addition (not deletion nor modification) of records. The default is no locking.
The other options are local filesystem locking or nfsfilesystem locking. If you wish
to share a database across multiple machines, you must use nfs locking.

In you use nfslocking, you must also set up and run an idserver, which ensures that
each client gets unique integers for id fields in the database(s). This may be useful
even when you are not using nfs locking, if you want to avoid duplicate ids among
several databases.

Here's an example of a descriptor file

#

schema ¢ss3.0

dblocks nfs

dbidserverxx.host.com

dbpath /opt/antel ope/data/db/demo/{ demo}

The example above is the current preferred format, but Datascope still supports an
earlier version which did not contain either dblocks or dbidserver. The order is
important for this descriptor file: schema on the first line, dbpath on the second:

¢ss3.0
/opt/antel ope/datal/db/demo/{ demo}

One can specify the idserver and the locking mechanism with environment vari-
ables (DBLOCKS and DBIDSERVER), but this requires all databasesto use the
same locking and id server.

Representation of Fields

While the field values are represented in ASCII format in the disk files, Datascope
converts them to three different binary formats for use in programs: double preci-
sion floating point, integer, and string. The calculator recognizes afew other types -
- boolean, time and yearday -- and converts between them as necessary. (Timeis

22
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represented as a double precision floating point, and yearday is represented as an
integer.)

Thereisactually one additional field type which Datascope usesinternally -- adata-
base pointer type. Thistype contains areference to asingle row or ranges of rowsin
another table. Thistypeisthe basisfor views and grouping of tables.

Schema Description File

The structure of the individual files and the database overall is dictated by a schema
file. Thisfile describes the fields of the database, and specifies how these fields are
used in each table. Datascope’s schemafile is unique in several respects:

e Theschemafileisatext file which isread and interpreted whenever a database
is opened. Changes in the schema file are reflected in the next execution of a
program which uses Datascope.

* A field with the same name has the same attributes (size, type, format) in every
table in which it appears. In other DBM Ss (DataBase Management Systems),
the same name might apply to entirely different kinds of fields.

* Thereisconsiderably more information associated with every field and table
than in most DBMS'. This additional information serves to document a data-
base, and al so allows Datascope to provide some more sophisticated operations
like joins and some automated verification tests.

A schemafile contains three types of statements: Schema, Attribute, and Relation.

Schema Statement

The Schema statement appears only once, at the beginning -- it provides a short and
along description of the schema overall. It is not required. The format of the state-
ment is:
Schema name
Description (“short description” )
Detail {
long description
}
Timedate time-stamp-field

Datascope: A Tutorial
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1

You may also specify afield containing atime which is modified automatically
whenever arecord is changed. For the CSS schema, thisfield is Iddate.

Attribute Statement

The Attribute statement describes a single field of the database. It specifies the size
and type of each field, aa(C printf style) format code, arange of legal values, anull
value, the units (if applicable), and a short and a long description of the field.

Attribute name
type (length)
Format ( “format” )
Range ( “expression” )
Null ( “null value™ )
Units ( “physical units’ )
Description ( “brief description” )
Detail {
Detailed description
}

Names should be a phanumeric, beginning with aletter. The legal types are Real,
Integer, String, Time, Yearday, and Dbptr. The length specification is the number of
charactersto alow for the printed representation of the field. The Format codeisa
(C) printf style format code that specifies how to trandate from the internal, binary
representation (integer, double or string) to the printed format.

The Null value varies from field to field, but represents afield for which informa-
tionisnot available. It is not the same asthe SQL NULL. It isusually avalue out-
side the Range.

The Range should be a boolean expression which istrue for valid values of the
field.

The Units specification is not currently used anywhere, but should specify the phys-
ical units of the field in cases where this has some meaning.

24
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The brief and detailed descriptions provide a convenient way of documenting the
schema, and are available for help screens.

Only the name, type, length, and format are required; however, filling in al the
clauses which make sense provides fairly extensive documentation.

Relation Statement

The Relation statement describes atable of the database. It has
the following format:

Relation name
Fields (field field ... )
Primary (key key ...)
Alternate ( key)
Foreign ( field field ... )
Defines field
Separator (“c’ “c")
Transient
Description ( “brief description” )
Detail {
Detailed description
}

The Fields clause lists the fields which make up arecord of the table.

Datascope allows specifying two keys for a database table, a primary and an ater-
nate key. The alternate key is often asingleid field. A key should identify a unique
record in the table; it isamistake if one key matches more than one record in the

table. Datascope does not prevent this situation, but dbverify will flag the problem.

A table may have fields which are basically indexes into other tables. Such fields
may be identified with the Foreign clause. Foreign keys must be singlefields, not a
compound key.

Datascope: A Tutorial
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Usually, aforeign key isanid field -- asmall integer which identifiesarow in a
table, but has no intrinsic meaning. Some examples from the CSS database are wfid,
arid and inid. These integers may be assigned in any arbitrary fashion, provided
they are al unique. Datascope has provision for automatically generating these ids
(see dbnextid(3)), but they must be identified in the schema by the Defines clause.

By default, Datascope separates the fields in a database record with spaces, and
separate records with alinefeed. Thisis convenient for editing with atext editor
(although tab would be a more convenient field separator for processing by awk).
These defaults may be overridden by specifying field and record separators; speci-
fying null strings will eliminate the separators atogether.

The Description and Detail clauses serve the same function as in the Schema and
Attribute statements, providing brief and more detailed explanations of the field.

The Transient clause is described below; it is not typically used in aschemafile.

Datascope Views

The schemafileis usually kept in acentral location, read and compiled whenever a
database is opened. It should specify all the central tables of the database. However,
it ispossibleto create additional tables on the fly. Such tables are Transient, have no
direct identification in the schemafile, and usually are not represented on disk
directly.

The most common and useful variety of such tables are simple views. Simple views
should be regarded (and are implemented) as arrays of database pointers. Each
database pointer in asimple view identifies asingle record of abase table. One
dimensional arrays (vectors) are useful as sorted lists and subsets of the records of a
single table. Two dimensional arrays represent joins of several tables; such joins
may also be sorted or represent subsets of the complete join. For instance, aview of
the site table (sorted and/or subsetted) could be described in the schema as

Relation site_view
Fields ( site)
Primary ( sta ondate::offdate )
Transient
Description ( “Example of simple vector view” )
Detalil {

26
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You create atable like thiswhen you
sort or subset the site table in dbe.

}

A simplejoined view might represent ajoin of the wfdisc, sensor, site, sitechan, and
instrument tables:
Relation data._view
Fields ( wfdisc sensor site sitechan instrument )
Transient
Description ( “Example of asimple joined view” )
Detail {
You can create atable like thisin dbe
by joining wfdisc to sensor, the result to
site, that result to sitechan, and finally
joining that result to instrument.

}

While asimple view consists only of database pointers, more complex viewswhich
mix database pointers and other types of fields are also possible.

An example of acomplex view isagrouped view. Thisview will have a set of fields
which are represented directly in the table, and a special database pointer which
refersto arange of rowsin another table. This other table may be abasetable, but is
more often itself asimple, sorted view. The database pointer which refersto arange
is aways named bundle; there is currently no provision for keeping more than one
such pointer in any table.

Reserved Namesfor Fields and Tables

The names of certain fields and tables bear a special meaning to Datascope. Thisis
probably a mistake, but the cost to specify these fields into the schema rather than
building them directly into Datascope was judged to be higher than the added value.

The particular choice of names usually relatesto the origin of Datascopein support-
ing the CSS schema. A few names support misfeatures of the CSS schema, and
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should just be avoided in new schemas, commid and lineno from the remark table,
and ondate and offdate in the site and sitechan tables are examples.

Other names are arbitrary choices which serve to implement necessary features. A
redesign might choose different names, but the functionality would be essentially
the same; dir, dfile, lastid, keyname and keyvalue are examples.

The CSS database provides a separate remark table for adding comments; many
tables then refer to a set of records in the remark table with the commid field. Each
record in the remark table allows 80 bytes for a comment; however, longer com-
ments can be entered by using multiple records with the same commid and different
lineno. In afew places, Datascope accomodates this scheme explicitly. Routines are
provided to add or extract comments. See dbremark(3) and dbremark(1).

The site and sitechan tables specify ondate and offdate, so-called “julian” days, for
the time range, rather than just time and endtime (epoch times). This makes it
impossible to specify changes in instrument orientation during a single day, and
complicates the join between other tables like wfdisc and sensor, which specify a
time range in epoch time. The different names must be recognized, and conversions
must be done from yearday format to epoch time format. To deal with this, Datas-
cope explicitly recognizes ondate and offdate, and explicitly handles cases where
tables with time are joined to tables with ondate and offdate. The further special
case of anull offdate indicating the indefinite future is handled explicitly. However,
you would be wise to avoid using ondate and offdate in any new tables or schemas.

Dir and dfile specify a pathname to afile outside the tables. Such files could be
regarded as another field of atable, but afield which the database is not capable of
manipulating directly. In the CSS schema, dir and dfile are used to refer to recorded
data, and to instrument response descriptions.

Waveform datais kept out of the database because of its volume. The parameter
datain the database is a very small fraction of the size of the collected data. It's
quite useful to have this parameter data online continuously and quite impossible
(for most users at least) to keep the collected data online all the time.

Theinstrument response information is an example of information which is not best
represented in arelational database form. While it would be possible to keep this
information directly in the database, doing so would confer no additional advan-
tages, and would have some direct costs in speed and convenience.
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In order to assign unique valuesto id fields when new records are added, Datascope
uses the lastid table. Keyname is the name of id, while keyvalue is the last assigned
integer for that id. Datascope increments the latter when a new record is added to
the table which defines the id. Other schemes might be devised to handle this prob-
lem, but thisis adequate.

A word of caution regarding id fields

Becauseid fields present afast and simple key to atable, there is atendency to
make lots of them, provide an id key for every table, and do the joins on these ids.
Thisisusualy amistake. If possible, avoid ids and make your keysthe combination
of meaningful fields which uniquely specify arecord in atable.

Whileids are simple and seductively attractive, they introduce some of the knottiest
problems in database management, whether you are using Datascope or any other
relational database management system. Because they have no meaning outside the
database context, if they are ever modified inappropriately, it may be difficult or
impossible to recover. 1d fields also complicate operations like merging or compar-
ing two databases, sometimes to the point of making the operation impossible. Ids
are especially bad in tables where the real key is atime range of some sort; wfdisc
and sitechan are good examplesin the CSS database. In either of these tables, any
particular record could be split into two records covering adjacent time ranges.
(This might be done to reflect actual changesin station parameters, or in the case of
wfdisc, just to segment the recorded data differently.) Doing so would not affect the
database integrity if al joins were made on the true keys of these tables. However,
joinswhich usetheidsin these tables (wfid and chanid) would no longer be correct,
and fixing up the problem could be difficult.

Finally, bundle and bundletype are newly introduced fiel ds which support grouping.
Bundle is the name given to a database pointer in a complex view which refersto a
range of rows in some other table. Bundletype is an integer which may be used to
specify thelevel of the grouping -- thet is, atable grouped by certain fields might be
further grouped by a subset of those fields.
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CHAPTER 4

Basc Datascope
Operations

Datascope provides all the standard operations which any RDBMS must, albeitin a
somewhat different fashion than the standard SQL approach. In addition to the sim-
plest operations of reading, writing, adding and deleting records, it's possible to
subset, sort, group, and join tables. You probably have an intuitive understanding of
the subset, sort, and group operations, and the underlying code is conceptually ssim-
ple. Joins are a bit more complex, and this chapter concentrates on explaining how
Datascope handles joins.

Reading and Writing Fields and Records

Datascope, of course, provides ways of doing this, translating from the ASCI| rep-
resentation of thefilesto abinary representation more convenient for programming.
Files which represent tables are mapped into memory and accessed as large arrays.
This means that the tables do not use up swap space, and it tends to be faster than
going through thei/o interface.

Deleting Records

Unlike most RDBM S, specific record numbers are used when reading or writing
records: e.g., record #10. These record numbers are directly manipulated by the
user. Because of this, deleting records can cause problems; deleting arecord

Datascope: A Tutorial

31



Basic Datascope Operations

changes the record number of all subsequent records. Thisis often inconvenient,
and consequently records may instead be marked for later deletion. Marking a
record setsall of thefieldsto null values; alater crunch operation deletes al records
which are null.

Subsets

The subset operation is pretty intuitive -- find al records which satisfy some condi-
tion, aboolean expression. This correspondsto the Where clausein SQL. However,
Datascope expressions are more flexible than most SQL implementations.

Sorts

The sort operation simply orders the records according to some set of sort keys.

Grouping

A sorted table may be grouped -- thisjust means that consecutive records which are
identical in some set of fields are separated into bins, and afew additional opera-
tions can be performed on these bins.

Joining Tables

The principal drawback of keeping datain arelational databaseisthat you must
regularly join tablesin order to extract information from the database. In the demo
database, given data recorded at station AAK and referenced in the wfdisc table,
you must look into the site table to find out the location of AAK, and into sitechan
to find out the orientation of the sensors, and into sensor and instrument to find out
the response of the instrument. The most convenient way to do thisisto construct a
join of wfdisc, sensor, instrument, site and sitechan.

Conceptually, you can imagine forming ajoin of two (or more) tables as follows:

1. Find al combinations of arow from each table.
2. Keep only the combinations which satisfy some condition.

This approach would involve calculating the expression m1* m2 * ... * mn times.
For complex expressions, the join must in fact be performed in this fashion. Datas-
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cope'sthetajoinis performed in exactly this manner. However, this can be slow and
expensive (try it), and it's often possible to use indexes to work much faster.

Natural joins among the tables of a database are those where the join condition is
that fields with the same name have the same value. For instance, when joining
wfdisc with site, the sta field should be the same in both the wfdisc row and the site
row:

wfdi sc.sta == site.sta

Forming the joined table which satisfies this condition can be done in a more effi-
cient fashion than by considering every possible combination of rows from wfdisc
and site. Instead, first sort site by sta, then proceed linearly through the wfdisc
table. For each row of wfdisc, find the rows in site which have the same sta by
searching the sorted list. Instead of m1 * m2 calculations, there are now more like
ml * log(m?2) calculations -- much quicker (you may need to consider thetime to
compute the sorted list, of course). Datascope performs natural joinsin exactly this
fashion.

In addition, of course, the time ranges in wfdisc and site should match. In Datas-
cope, thisis taken to mean that the time ranges overlap. (In practice, this often
means that one time range falls compl etely within the other; it is sometimes a data-
base inconsistency if thisis not true.)

Datascope provides amethod of indexing time ranges. Thisis more difficult than it
may at first appear. Consider a number of overlapping time ranges -- how should
they be sorted? There is no unique ordering for overlapping time ranges. They
might be sorted by starting time, by ending time, by the midpoint, etcetera. Some
choice must be made, and Datascope chooses the one you probably thought of first;
it sorts by starting time. However, if atime range index consisted of just starting
times, on average the join expression would need to be computed on half of the
indexed table for each record of thefirst table. To avoid this, Datascope first sorts
by starting time, then computes a monotonically increasing envel ope function of
end times. The start times and this envel ope function have the same sort order, so
that the set of candidate matchesis considerably restricted. Nonethel ess, range
indexes are more costly to compute and to join with than indexes on simple or com-
pound keys.
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Inferring Join Keys

If you don’'t specify the keys by which to join tables, an attempt is made to infer the
keys based on the primary, alternate, and foreign keys specified for the two tables.
The process is based on matching names for the keys of the two tables. It proceeds
asfollows:

1. If any foreign key inthefirst table isapart of the primary or aternate key in the
second table, useit asthejoin key.

2. If any foreign key in the second table is a part of the primary or alternate key in
thefirst table, use it asthe join key.

3. Comparethe primary keys of thetwo tables; if any fields match, use those as the
join keys.

4. Compare the alternate keys of the two tables; if any fields match, use those as
the join keys.

5. Compare the primary keys of the first table to the aternate keys of the second
table; if any fields match, use those as the join keys.

6. Compare the primary keys of the second table to the alternate keys of the first
table; if any fields match, use those as the join keys.

The processis complicated somewhat by the presence of ranges, for example atime
range. A range matches another range with the same start and end names. (Asa spe-
cial concession to the CSS 3.0 database, time::endtime will also match ondate:: off-
date. The original decision to have the fields ondate and offdate was flawed.) A
range will also match a single field which has the same name as the start of the
range. For instance, time will match time::endtime.

Tables which are the result of joins inherit a subset of the keys possessed by their
parents. This processis strictly ad hoc, and is not guaranteed to produce the correct
subsequent joins. However, it is very often correct, and by careful choice of the
order in which you join tables, you can usually force the correct join.

Inheritance of keys

The inheritance of keysin joined tablesis based strictly on the names of the keys.
The primary key for the joined table is the set of unique names from the primary
keys of the two parent tables. The alternate and foreign keys are similarly consti-
tuted.
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Once again, the presence of ranges complicates matters. If the parent tables had
time and time::endtime as part of their primary key, the joined table will have both
time and time::endtime as part of its primary key. However, because both time's are
unqualified, the time from thefirst table in the join will be used in later joins. This
will probably not be the right choice.

Specifying Join Keys

To be absolutely certain you have the correct join keys, or to override the inferred
join, you may specify join keys. Join keys are specified as two lists of fields or
ranges; one list for each table. Often these two lists areidentical. Ranges are indi-
cated by the double colon separating the lower and upper boundary of the range.
Note that the keys need not be just simple field names; they may a so be expres-
sions.

Speed and efficiency

Datascope aways performs the joins two tables at atime, in the order you specify.
Anindex isalways used for the second table, while thefirst table is stepped through
linearly. This can be useful for verifying that every record in the first table joins
with one or more records in the second table, or identifying the records which don't
join. (Finding the records which join with multiple records in the second tableis
more difficult).

However, your usua concerniswhat'sfastest? A commercial DBM S will probably
attempt to figure this out for you, and compute the join in the most efficient fashion.
In Datascope, you must figure it out on your own. If it's really important, time the
command line utilities. But as arule of thumb, joins will be fastest if the second
table has more rows and has the necessary index precomputed. If an index must be
computed to perform thejoin, thenit'sfaster (usually) if the second table has fewer
rows.

An operation which is complementary to ajoinisto find all the records which do
not join with a second table. Such records often indicate a database problem of
some sort. The join operation (from the C interface) returns alist of these records,
and the dbnojoin command and tcl and perl operation provide a view containing
these records.

Once you have ajoined view, you may want to take it apart. Datascope provides a
few operations which do this. dbsever removes one table from a view, keeping only
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rows which are unique in the output view. A related operation is dbseparate, which
formsaview of all the records from a particular table which participate in the input
view. A view may also be taken apart with dbunjoin, which creates new tables con-
taining only the records which participate in aview. A corresponding operation is

toreturn alist of all the records participating in the view for each table in the view.

A view isasomewhat static snapshot into a database It is a set of references to spe-
cific records in the database. Changes in the fields of existing rows of the database
will be reflected in the view, if you get the value of afield. However, the view will
not change as new records are added, nor because changing fields would result in a
different view if the view were recomputed. A program which needs a more
dynamic window into the database must either recompute the view frequently, or
may find the dbmatches operation to be useful. domatches finds the collection of
records in a table which would satisfy a certain join condition; it does not create a
new joined view, it just returns the list of records. The user must index through
those records; thisis more lightweight and more convenient in many situations.

Summary

Datascope database operations are the guts of the database system; it'slargely these
operations which provide the power of the database. However, like arithmetic, there
are not that many operationsto learn: subset, sort, join, group and a few other
closely related operations. All these operations are probably familiar from set the-
ory in junior high school, or in recent years, first grade.
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CHAPTER 5 Expresson Calculator

Datascope has a very useful expression calculator. Expressions are used in many
ways:

* tocreate asubset of atable

* asasort key or ajoin key

¢ to calculate avalue which doesn’t appear directly in atable

* inthe schema, to specify the legal range of afield.

Expressions have afamiliar algebraic format, and are quite similar to expressionsin
¢, FORTRAN and awk. You may find it instructive to play with expressions as you
read this section, using the program dbcalc. dbcalc simply reads expressions from
standard input, and evaluates them, printing the result. You need to give it a data-
base tableto use. Try

% dbcal ¢ denp. wfdi sc

And you can follow along, typing in the expressions below.
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Basic Operators and Database Fields

Of course, the calculator understands the basic operators. '+, -, "*" and'/’. Data-
base fields are treated like named variables, and may be intermixed with literals.
For example:

tine

5/ 21/ 1987 5:04:37.000
(nsanmp-1)/sanprate + tinme
5/ 21/ 1987 5:05:28. 996
endti nme

5/ 21/ 1987 5:05: 28. 996

The specific results depend on the particular record selected, of course. For clarity,
the precision of the printed values has been limited; floating point numbers are all
internally double precision.

In addition to the familiar operators, the calculator understands’ %' for modulus
and 'V for exponentiation, and afew bitwise operators are understood:

1075
100000
1.372.1
1.73
15 % 4
3
25.3 %. 25
0.05
1<<5
32
28 >> 3
3
25 & 3
1
10| 3
11
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Data Types

The calculator understands afew basic data types, and converts between them as
necessary. Thus a string may be converted to an integer, or an integer to afloating
point number, or a number to a string, depending on the context:
10 + ' 13
23
10 + '13.5
23
10.0 + '13.%
23.5
10 + 13.5
23.5

Each field in a database table has a specified type; the type of input literalsisdic-
tated by their format. A number without adecimal point is an integer, a number
with a decimal point is floating point. Strings are enclosed in single or double
quotes. Theresult of 10 + ' 13. 5’ may have surprised you; because the first
operand was an integer, the string was converted to an integer, not a floating point.

Some conversions can be done explicitly:
ceil(-3.5)
-3
floor(-3.5)
-4
int(-3.5)
-3

String Operations

Strings have afew specia operations; “.” isthe concatenation operator:
a” . 'b

“ab”
;' . chan

“

sta .
“KKL: HBI E”
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dir . '/ . dfile
“sac/ 1987141050437. 00. KKL. HBI E”

The extfile function returns the path to an external file specified by the special fields
dir and dfile in the record.
extfile()
“ex/ sac/ 1987141050437. 00. KKL. HBI E”
extfile(“w disc”)
“ex/ sac/ 1987141050437. 00. KKL. HBI E”

Noticethat thisis not necessarily the same as the concatenation of dir, ’/*, and dfile.
If the path is not an absolute path, it isrelative to the location of the file which con-
tainsthe table.

The optional argument to the extfile function is the name of atable. In some cases,
ajoined view may contain multiple dir and dfile fields. (Consider ajoin of wfdisc,
sensor and instrument, for example.) In this case, specifying a particular base table
(instrument, for example) ensures that you get the external file specified in that
table.

Pattern matching and pattern substitution are available;

chan
“HBI E”
chan =~ /.*E
true
chan =~ [.*Z/
fal se
chan =~ [ E
fal se
sta =~ / AAK| CHM KKL/
true
time
5/21/1987 5:04:37.000
time =~ /.* 5:0.:.%/
true
patsub ( chan, “HB", “BH )
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“BHI E”
patsub ( sta . “/” . chan, "([A-Z]+)/([A-Z]+)", '$2/%$1")
“HBI E/ KKL”

The pattern matching expression is a standard UNIX regular expression. Read the
sed man page for a complete description. The pattern must match the entire string
on the left, not simply be a part of it. However, strings from fields are stripped of
leading and trailing blanks before being used in calculations.

The pattern substitution pattern (second parameter of the patsub function) need
only match part of the string (first parameter). Aswith sed and perl, matching sub-

expressions (delimited by parentheses as shown above) can be referenced in the
replacement string as $1 through $9.

L ogical Operators

There are the typical (C form of) logical operators:

chan == "HBIE
true
chan > ' HB
true
calib !'= NULL
true
commid == NULL
true
In simple expressions with afield on the | eft, followed by the operator '==" or '!=",

NULL isunderstood as the null value for that field.

When atimefield is compared to a string literal, the string may specify timein a
variety of recognizable formats. Most common formats will be recognized prop-
erly. (See the man pages epoch(3) or epoch(1) for more examples).
tine
5/ 21/ 1987 5:04:37.000
tinme > “5:04:35 May 21 1987"
true
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time > “5/21/87" && tinme < “5/22/87"
true

time < “5/21/87" || tinme > “5/22/87"
fal se

time > “5:04 pm5/21/87"
fal se

time > “1987141"
true

time > “1987 (141)”
true

Another operator borrowed from cisthe’?, which evaluates an expression and
returns one value if the expression is true and a second value if the expression is

false:

calib
1.2

calib ? calib: 1.0
1.2

chan
“HBI E”

chan == “HBlI 2" ? “vertical” : “horizontal”
“hori zontal”

While this syntax can be confusing, it takes the part of if .. elsein the calculator.
You can read

el ? e2 : e3

if (el)
e2

el se
e3
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Assignments

Sometimes expressions can change the value of afield. The assignment operator is
:= to make it difficult to mistakenly make an assignment. NULL isalso understood
asthe null value for the field in this context.
commid := NULL
-1
endtine := time + (nsanp-1)/sanprate
5/ 21/ 1987 5:05: 28. 996

Asin C, the value of an assignment is the value assigned. Operators may be mixed
in arbitrarily complex expressions. The precedence of operatorsisthe sasmeasC,
and parentheses may be used to make the order of evaluation explicit.

Standard Math Functions

There are anumber of math functions. The usual trigonometric functions:
si n(30)
0.5
cos(45)
0. 707
tan(90)
-2.61e+15
tan(0)
0
tan(45)
1
atan(sqrt(1-.5"2), .5)
60

For convenience with the CSS database, arguments and results are in degrees,
rather than radians.

There are also the familiar natural and common logarithms, square root, absolute
value and min and max. Sign returns one, zero, or negative one, depending on the
sign of the operand.
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| og(10)
2.3
| 0g10( 10)
1
exp(lo0g(19.5))
19.5
sqrt(2)/2.0
0. 707
abs(-5.3)
5.3
mn(-5, -3)
-5
max(12, 30)
30
sign(-5.3)
-1
sign(0)
0
sign(1l.5e-30)
1

Time Conversion

There are avariety of functionsto convert among several common time formats.
epoch converts ayear/day of year integer (for example, day 35 of year 1973 is
1973035) -- sometimes termed a julian day-- to an epoch time: seconds since Janu-
ary 1, 1970. yearday takes an epoch time and converts back to the yearday format.
strdate and strtime provide a standard conversion from epoch time to the more eas-
ily understood date and time format. date2e takes a year, month, day, and seconds
of that day, and converts to an epoch time. The str2epoch function converts astring
to an epoch time. now returns the current epoch time (as reported by the local sys-
tem).

epoch ( 1987244 )
9/01/1987 0:00: 00. 000
yearday ( “9/1/87" )
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1987141
strdate ( tine )
“ 5/21/1987"
strtine ( tine )
“ 5/21/1987 5:04:37.000"
date2e ( 1987, 5, 12, 2*3600+34*60+5.35 )
5/ 12/ 1987 2:34:05. 350
str2epoch(“Jan 25, 1993 11:23:5.4")
1/ 25/ 1993 11:23: 05. 400
now ()
10/ 15/ 1994 23: 04: 46. 000

Spherical Geometry

There are several functions related to distances around a spherical earth. Distances
are expressed in angular degrees; azimuth is measured clockwise from geocentric
north.

distance gives the angular distance between two points, while azimuth computes
the direction from one point to the second. latitude and longitude compute the
inverse operation -- the resulting latitude and longitude when moving a certain
number of degreesin a particular direction.
di stance(origin.lat, origin.lon, site.lat, site.lon)
13.7234
azinmuth(origin.lat, origin.lon, site.lat, site.lon)
306. 345
latitude(origin.lat, origin.lon, 13.7234, 306. 345)
56. 4001
| ongi tude(origin.lat, origin.lon, 13.7234, 306.345)
58. 6001
site.lat
56. 4
site.lon
58.6
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(The computed site.lat differs from the actual site.lat because of roundoff error in
the distance and azimuth).

Seismic Travel Times

A seismic travel time calculator isbuilt in. ptime and stime calculate the travel time
for thefirst p and sarrival. (The arguments are distance in degrees, followed by
depth in kilometers; for phase_arrival, the argument is velocity in degrees/second).
ptime(5.105, 155.166)
74.8333
stime(5.105, 155.166)
133.79
pti ne(5.105, 155.166)+origin.tine
4/ 27/ 1992 10: 52: 55. 502
stine(5.105, 155.166)+origin.tine
4/ 27/ 1992 10: 53: 54. 459
parrival ()
4/ 27/ 1992 10: 52: 55. 502
arrival (“Pn")
4/ 27/ 1992 10: 52: 55. 502
sarrival ()
4/ 27/ 1992 10: 53: 54. 460
arrival (“Sn”)
4/ 27/ 1992 10: 53: 54. 460
arrival (“PcP")
4/ 27/ 1992 10: 59: 52. 549
phase_arrival (. 6)
4/ 27/ 1992 10:51:49. 177

ptime and stime may always be evaluated. However, parrival, sarrival, and
phase_arrival require ajoin of origin and site, because they use fields from both
tables. parrival is shorthand for:

origin.tinme+pti me(di stance(origin.lat, orgin.lon,site.lat,
site.lon), origin.depth)
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and sarrival is shorthand for:
origin.tine+stime(di stance(origin.lat,origin.lon,site.lat,
site.lon), origin.depth)

and arrival is shorthand for:
origin.time+phaseti ne(phase,di stance(origin.lat,origin.lon,
site.lat, site.lon), origin.depth)

phase_arrival(velocity) is shorthand for:
origin.tine + distance(origin.lat, origin.lon, site.lat,

site.lon)/velocity

Note that the specified velocity is in degrees/second, not kilometers per second as
you might have expected.

Seismic and Geogr aphic Region functions

The Flinn-Engdahl seismic and geographic region functions are built-in. grn and
srn take two arguments -- latitude and longitude in degrees -- and return the corre-
sponding geographic or seismic region number, respectively. gregion and sregion
take the same arguments, but return the names of these regions.

sta
“H A
| at
49. 2667
| on
119. 742
grn(lat,!|on)
657

gregion(lat,|on)

“E. USSR-N.E. CH NA BORDER REG ”
srn(lat, | on)

41
sregi on(l at, | on)

“EASTERN ASI A”
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Conglomerate functions

A few functions operate on an entire table or a group.

max( | at)
43. 2669
m n(l at)
42.0778
count ()
20
sun{l at)/count ()
42. 6158

min and max (with a single argument) find the minimum or maximum value of the
expression over the entire range of the table or group. count returns the number of
records, and sum computes the sum of an expression, calculated over al the rows of
atable or group.

Whether to compute over an entire table or over a group is decided based on the
presence of the field bundle, which is normally present only in agrouped view. For
these grouped views, the computation is done over just arange of records, in the
subsidiary table. You can force the cal culation to range over the entire table instead
by using min_table, max_table, count_table, or sum_table.

External functions

It's possible to execute a shell command and return avalue. The syntax for thisis
borrowed from tcl/tk:
[“date”]
“Sat Cct 15 20:29:21 MDT 1994
Totece” extfile()]

88368 /j spc/ wf/ prod-
uct s/ casi a_wavef or ns_nay92/ wf/ knet ¢/ 1992/ 138/ 210426/ 19921
382148. 07. CHM BHz”

[“V\C

Note that the string literal arguments must be quoted; the list of expressions which
make up the command line are evaluated just like any other expression.

48 Datascope: A Tutorial



CHAPTER 6

Programming with
Datascope

While agreat deal can be accomplished with just dbe, ultimately you will probably
need to write specialized scripts and programs. You might want to generate reports
offline, for instance. In addition, there are many kinds of problems which can’t be
solved by just manipulating sets. Finally, Datascope doesn’t address the issue of
external files (in seismology, the actual waveform data) beyond providing away of
indexing them.

You can attack programming problems from a variety of levels with Datascope.
Some problems, (like generating areport) can easily be solved with Datascope's
command line utilities. These provide the basic operations (subsets, joins, and
sorts) at the command line. If you can get atable display from dbe which is what
you want, then you can also write a shell script to generate the same information.

When the problem isalmost solved by the command line utilities, you can often use
standard shell tools like awk, sed or perl to finish the job.

Problemsinvolving conversionsto or from another RDBM S might be handled most
easily with the perl interface, because perl is quite good at text manipulation, and
also has interfaces to many of the standard RDBMS.

The command line utilities are also convenient for generating the input data set for
more complex analysis. Rather than build a selection process into a program, use
the command line utilities to select an interesting subset of data from the database,
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read the resulting view directly in the program, and concentrate in the program on
solving the problem. This approach is likely to lead to more general purpose pro-
grams.

Especially when aGUI interfaceisdesired, consider tcl/tk. Antelope providestcl/tk
extensions which provide direct access to most of the functionality of Datascope
and many other Antelope functions. The tcl interface is probably the easiest to
learn, after the command line interface. Because tcl may be run interactively, you
can (and should) devel op an interactive development style: typein afew commands
at atimeinside atcl or awish, before saving them into a script file. The process of
creating an application under X Windows is dramatically simpler with tk than with
c. dbeisitself atcl/tk script, as are several other Antelope programs.

Thereis aso acomplete perl interface into Datascope and many other Antelope
functions. Perl is ajack-of-all-trades language, particularly prized by system
administrators. It's fast, easy to write, and widely available. Many people prefer it
to tcl/tk and c.

The Datascope library is written in common ¢, with afew yacc and lex parsers.
Consequently, the interface has a distinctly c flavor, and the c interface is the best
supported and tested. For problems which cannot be solved by simpler means, the c
interfaceis preferred.

In some primarily numerical applications, (or because of familiarity with the lan-
guage), FORTRAN may be the preferred language. FORTRAN's limitations with
respect to dynamic memory allocation and string manipulation make it difficult to
support al of the Datascope functionality. However, most of the ¢ interface to Data-
scope has a FORTRAN counterpart of the same name, sometimes with slightly dif-
ferent parameters.

If you have a numerically complex problem, or you want extensive graphics sup-
port, and have access to it, you may consider Matlab. Kent Lindquist has a contrib-
uted matlab package which provides access to many Antel ope functionsincluding
Datascope.

Sample Problem

At this point, you should already be familiar with Datascope from exploration with
dbe. This chapter introduces the programming interface by considering asimple
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example problem. It will not go into detail about the usage of any particular Datas-
cope cal; for the complete story, please ook up the man page.

The problem to be solved isto find all the arrivals associated with an event, ordered
by arrival time, and for each arrival, to show the station, arrival time, phase, and dis-
tance to the event. Thisis easily done from within dbe in the demo database:

1. bring up the origin table.

2. select one origin, by entering itsorigin id (orid) in the entry area and selecting
subset from the menu under the orid column header. (Use orid 645)

3. jointhissubset to the assoc table, thento the arrival table, and finally to the site
table.

4. sort by arrival.time.
5. Usethe arrange dialog to show sta, arrival.time, .delta, phase.

You should get adisplay like the following:

" "
~\/0pt/antel0pe/data/db/demo/demo.Vi\ . \J\
File Edit ¥iew Options Graphics Process Help
ok x] [«[~>
0 sta arrivaltime delta |phase
- [aak [ 5/17/1982 (138) 21:55:46.350 1.928 P

KBK | 5/17/1992 (138) 21:55:51.350 2.230 (P
CHM | 5/17/1992 (138) 21:55:52.347 2.289 (P
USP | 5/17/1992 (138) 21:55:52.400 2.325 (P
TKM | 5/17/1992 (138) 21:55:55.450 2.566 (P
AAK | 5/17/1992 (138) 21:56:15.340 1.928 (5
KBK | 5/17/1992 (138) 21:56:24.434 2.230 (5
CHM | 5/17/1992 (138) 21:56:27.289 2.289 (S
7|USP || 5/17/1992 (138) 21:56:28.129 2.325 (5
19K 1
Dismiss

This problem isvery simple, but servesto introduce various approaches to the prob-
lem. (As an exercise, and to get a better appreciation of what you gain by using
Datascope, you might try solving this problem working directly against the text
filesusing c, FORTRAN, and/or perl. Or create the SQL to generate this report
from a standard RDBMYS).

The examples of implementationsin shell, tcl, perl, c and fortran in the remainder
of this chapter are also available in the examples section of the Antel ope distribu-
tion in the directory $ANTEL OPE/exampl e/datascope.
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At the command line

The command line utilities provide the basic join, sort, and subset functions of dbe
as commands that can be joined together into pipes. The commands are named after
their function, and have the same names as their corresponding library routines:
dbjoin, dbsort, and dbsubset. The output of dbjoin, dbsort, and dbsubset is binary;
don’t try to display it on your terminal or window. dbselect reads this binary output,
and displays selected fields (or expressions).

The output of dbjoin, dbsort, and dbsubset is asimple view -- an array of database
pointers with alittle bit of header information. This output can be saved to disk and
read |ater. Following the table naming conventions, or by using the -n option,
allows a saved view to be read like another table of the database. However, because
views contain references to specific record numbers in the base tables, they can be
invalidated by changesto origina tables. Datascope detects changes by checking
modification dates, and will not open out of date views.

Converting the process outlined in dbe above to the command line is straightfor-
ward:

1. Begin with the origin table, and select only orid 645:
dbsubset deno.origin “orid == 645" | \

2. Join thisresult with the assoc, arrival, and site tables, by piping the results to
dbjoin:;
dbjoin - assoc arrival site | \
3. Sort by arrival.time:
dbsort - arrival.time | \

4. Print out the fields of interest:
dbselect - sta arrival.tine assoc.delta assoc. phase

Here' s the result:

AAK 706139746. 35000 1.928 P
KBK 706139751. 35000 2.230 P
CHM 706139752. 34740 2.289 P
USP 706139752. 40005 2.325 P
TKM 706139755. 45010 2.566 P
AAK 706139775. 33963 1.928 S
KBK 706139784. 43397 2.230 S
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CHM 706139787. 28949 2.289 S
USP 706139788. 12868 2.325 S

dbselect does not print epoch timesin an easily understandable format; for some-
thing easier, specify strtine(arrival . tinme) instead of arrival . tine. (To
get raw epoch times in dbe, deselect the “ Option->Readable times”).

The command line utilities are by far the easiest and most concise of the program-
ming interfaces, though they are somewhat limited. Generally, they provide the
same kinds of manipulation as dbe. In two areas, however, the command line utili-
ties are (currently) more flexible:

¢ dbjoin alowsyou to explicitly specify the join keys between two tables. This
makes it possible to join the event and the origin tables on the condition that
event . prefor == origin. orid,for example.

» dbselect allows tablesto be grouped by some set of fields, and allows printing a
header and footer around each such group.

Database pointers

Before going on to the tcl, ¢, and FORTRAN interfaces, it is useful to introduce a
few concepts and utilities which are used in al three interfaces.

First, most Datascope library calls use a construct called a database pointer. In c,
thisis declared as a struct, Dbptr. In FORTRAN, it isan array of four integers, and
intcl, itisalist of four integers. A database pointer is used to address a range of
database parts, from a specific field in arecord in atable, to awhole record, to a
whole table, to awhole database. The integers which make up a database pointer
index structures internal to Datascope. However, these various integers may be
manipulated directly by the user. The variousintegers are

e database #

The database number isjust the index corresponding to the order in which data-
bases were opened. A typical application may only open one database, in which
case database number would be zero.

* table#

Table number isjust the sequence number of the table in the schemafile; as
views are created, they receive higher numbers.
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o field#
Field number is the sequence number of the field in the table.
e record#
Record number is the sequence number of the record in the table.

Note that all these numbers follow the ¢ convention of being zero based, starting at
zero, rather than the FORTRAN convention of starting at one.

Typicaly, the user will directly manipulate only the record number and use
dblookup to find table and field numbers. The various numbers are dynamic; except
possibly for record number, they will not vary during a particular execution of the
program, but they may very well change from one execution to the next (if the
schemafile changes, for instance). That is, the database pointer for a particular field
in aparticular record of a particular database may be different the next time the pro-
gramisrun.

These indexes may also take on afew special values. dbALL, doSCRATCH,
dbNULL, or doINVALID. When the field number is dbALL, the database pointer
refersto the entire record. Similarly, when the record number is dbALL, the data-
base pointer refersto the entire table. (However, it is not valid to have field number
refer to afield and record number be dbALL).

The record number may be dbSCRATCH or doNULL, in which case the database
pointer refers to two special records for atable; the “ scratch” record, and the null
record. You may assemble anew record in the scratch record before adding it to the
table, and you may read null valuesfor fields or records from the null record.

One last special case must be mentioned; a database pointer which specifies a con-
tiguous range of records from atable. In this case, the field index does not refer to a
field, but rather is the number of the last record of the range, plusone. A field
named bundle contains a database pointer which refersto arange of records.

A few programming utilities

Programming in tcl, ¢, or FORTRAN with Datascope requires becoming familiar
with asmall set of utility functions, in addition to the Datascope library routines.
These utility functions relate to:

e error handling
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* time conversions
e associdtive arrays
* lists

e parameter files

In tcl, associative arrays and lists are part of the language; in c or FORTRAN there
are a set of special routines to manipulate them. The relevant man pages are
error_handling(3), epoch(3), arr(3), thl(3), and pf(3).

Error Handling

Libraries should not, as arule, print out error messages. On the other hand, it's
quite difficult to pass adequate information back up the calling sequence and having
aset of return codesis very limiting and difficult to accomplish. Conseguently,
there are a set of routines which maintain an error log. When alibrary routine
encounters a problem, it leaves a verbose message on the error log (by calling
elog_log(3)), and then returns a generic error return code. The calling program
must manage the error register. Typically, it will want to print the messagesin the
error register using complain(3).

Programs often benefit from a standard error reporting routine, and the error han-
dling library provides this also. These routines should be initialized by calling
elog_init(3). die(3) prints an error message, and exits; complain prints an error mes-
sage and returns. Both routines print and clear the current error log.

Time conversion

Internally, al time calculations are based on an epoch time, quite similar to thetime
returned by the UNIX time(3). Thistime isthe nomina seconds since January 1,
1970. In Datascope, it is represented in a double precision number, which resultsin
an accuracy to at least the millisecond range for times of interest. However, atime
presented in seconds is difficult to appreciate, so time is often converted between
epoch seconds and some more readable format like June 22, 1992 13:34:45.345.
There are a set of routines for conversion between the two formats. The central rou-
tines might be str2epoch, which converts afairly arbitrary time-date string to epoch
seconds, and strtime, which converts an epoch time to a standard format a bit like
the example above. Read the man page epoch(3) to learn more, and use the program
epoch(1) to perform conversions on the fly.
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Associative Arrays

Associative arrays, i.e. arrays indexed by a character string rather than an integer,
are quite handy for avariety of problems. One variety of associative arrays are
implemented in the arr(3) routines. In this case, the arrays are implemented as bal-
anced (red-black) binary trees. (In contrast, the associative arraysin tcl are imple-
mented as hash tables.) Much of Datascope’s internals are implemented using these
associative arrays, and Datascope sometimes returns an associative array. Read the
man page for more detail. Arrays are not directly accessible from FORTRAN.

Lists

Associative arrays and lists are complementary. Lists and arrays are used exten-
sively in Datascope'sinternals. Some arguments to Datascope routines arelists, and
Datascope sometimes returns lists. Datascope indexes are sorted lists. Lists are
declared Thl *, and the list routines all have the suffix tbl: settbl, pushtbl, gettbl,
poptbl, newthl, etc. Lists are managed as one dimensional arrays (vectors); the
array contents are commonly (but need not always be) pointers to strings. The thl
routines provide avariety of common list manipulations; see tbl(3) for more detail.
Some list operations are availablein FORTRAN.

Parameter files

It's often convenient to keep some configuration datafor programsin a separate text
file. This allows the program to be more flexible, but avoids the problem of the
overloaded command line. The Datascope library doesn’t use parameter files
directly, but several of the command line utilities and dbe do use parameter files.
Basically, the parameter files allow avariety of configuration parametersto be spec-
ified by namein afree-format fashion in acentral file. This parameter file can also
be personalized. Parameter files are read and used as associative arrays (key-value
pairs), where the values may be simple strings (scalars), associative arrays or lists.
The depth of nesting of arrays and lists has no set limit. Read pf(3) for more detail.

Overview of tcl, perl, ¢, and fortran solutions

The solutionsin tcl, perl, c and FORTRAN to the simple problem above al look
quite similar; the differences relate primarily to the different syntax of the lan-

guages.
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1. Each program begins by opening the database using dbopen. This operation
returns a database pointer which specifies the entire database.

2. From this database pointer, other pointers which specify the origin, the assoc,
the arrival and the site table are generated, using dblookup.

3. dbsubset is applied to the origin table, returning a view which contains only the
oneorigin.

4. Theresulting view isjoined using dbjoin, first with assoc, then with arrival, and
finaly with site.

5. Thejoined view is sorted using dbsort.
6. Finally, selected fields from each record are fetched using dbgetv, and printed.

Overdl, the processis quite similar to the process in dbe or at the command line,
but more of the hidden details become evident. Rather than specifying tables
directly by name, database pointers are used. The new calls are dbopen, dblookup,
dbquery, and dbgetv. dbopen initializes Datascope to alow tables from a database
to be used; it returns a database pointer which specifies a database. dblookup is
used to further qualify a database pointer to specify a particular table. dbquery is
used generaly to find ancillary information about a database, table, or field -- in
this example, to find the number of recordsin atable.

Tcl/Tk interface

Tcl isasimple interpretive language designed and written by John Ousterhout. It is
widely used on avariety of platforms. It was intended as akind of glue to put
together more complex operations, something like UNIX shells, but with more flex-
ibility. Tk is an x-windows toolkit built on tcl. It allows creating applications with
windows and other widgets from a script or interactively.

The source code for tcl/tk is freely available, and so the language can easily be
embedded in your own application. Usually, this means adding a few specialized
commands to the basic language and then writing the application in the resulting
script language. Datascope takes this approach, providing two shells: atcl (no x
windows interface) and awish (awindowing shell).

A programin tcl is a script, which may be run at the command line directly. Alter-
natively, you can just run atcl or awish, and type in the lines. This latter approach
may be more instructive, and is a useful approach when writing your own scripts;
try them out directly. Here's the script:

#!/ bi n/ sh
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# This conment

exec atcl -f $0 $*

package require Datascope

set
set
set
set
set
set
set

db
db
db
db
db
db
db

| oop i

puts [dbgetv $db 0 $i
assoc. phase]

}

[ dbopen denp r+]

[ dbl ookup $db O origin 0 0]

extends to the next

[dbsubset $db {orid == 645}]
[dbj oi n $db [ dbl ookup $db 0 assoc 0 0]]
[dbj oin $db [dbl ookup $db 0 arrival 0 0]]
[dbj oi n $db [ dbl ookup $db 0 site 0 0]]
[dbsort $db arrival.tinge]

0 [dbquery $db dbRECORD_COUNT] {

line for tcl \

sta arrival.tine assoc.delta

If you'refamiliar with shell programming, thiswill all look pretty familiar. Thefirst
threelines are atrick to get awish running regardless of whereit’sinstalled on your
system. In the body of the program, the square brackets replace the shell’s back-

tick, and cause acommand to be executed before therest of the line, with the results

of the execution replacing that part of the line. The curly braces correspond to sin-
gle quotesin the bourne shell. These replacements allows embedding quotes within
quotes, and commands within commandsin atcl command.

Here are the results:

706139746.
706139751.
706139752.
706139752.
706139755.
706139775.
706139784.
706139787.
706139788.

35000
35000
34740
40005
45010
33963
43397
28949
12868

NN RN NN R

928
230
289
325
566
928
230
289
325

w u W w T T T U T
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Once again, there is no conversion from epoch seconds to a readable format. How-
ever, the standard time conversion routines are available inside tcl.

Intcl, an error return from a Datascope library call raises an exception, which prints
amessage, and stops the execution of a script. Thisis quite different from c or
FORTRAN, where you must yourself test the return code. To override this behav-
ior, use the tcl catch command.

Variables need not be declared in tcl. Database pointers are kept aslistsin avari-
able; try put s $db to seethe contents. Generally, the arguments are the same as
the argumentsin ¢, but since al tcl variables resolve to strings, there is no need to
put quotes around names like demo, origin, and arrival.time above.

Documentation on the tcl interface is limited to usage lines in the man page for
dbwish(1). It will often be useful to read the c man page when more detail about the
arguments or results is needed.

If you need to learn tcl/tk, a good place to start is John Ousterhout’s book, Tcl and
the Tk Toolkit. Once you've begun writing programs, you'll probably find the
dbhelp program to be quite useful, in much the same way the man pages are useful
when programming in c.

The perl interface

The perl interface is quite similar, but with a perl flavor. In perl, the database point-
ersare kept in perl lists. Thisinterface requiresthe 5.0 version of perl, not the older
4.036 version.

Here's the perl routine:

#!' [ usr/bin/perl

use Dat ascope ;

@b = dbopen ( “demo”, “r” ) ;

@b = dbl ookup(@b, “”, “origin”, “”, “" ) ;

@b = dbsubset (@b, “orid == 645" ) ;

@b = dbj oi n( @b, dbl ookup(@b, “”, *assoc”, “”, “") ),
@b = dbj oi n(@b, dbl ookup(@b, “”, “arrival”, “", “") ) ;
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@b = dbj oi n( @by dbl OOkup( @b’ “ "’ “gij te"’ “ n’ “ ") ) :
@b = dbsort (@b, “arrival.time” )

$nrecords = dbquery( @b, “dbRECORD_COUNT")
for ( $db[3] = 0 ; $db[3] < $nrecords ; $db[3]++ ) {
($sta, $tine, $delta, $phase) = dbgetv (@ib,
gw(sta arrival.time assoc. delta assoc. phase));
print “$sta $tinme $delta $phase\n”
}

The results are identical with the tcl results.

Thecinterface

Most routinesin the c interface have areturn code; typically zero indicates success,
and a negative value, usually dbINVALID, indicates failure. Some routines return a
database pointer, rather than an integer return code. In these cases, an error isindi-
cated by individual components of the database pointer taking the value dbl N-
VALID. (Except for dblookup, al the components take the value dbINVALID).
Error messages are left on the error log. To print them, use complain(3), die(3), or
clear_register(3).

Here'sthe programin c:

#i ncl ude <stdi o. h>
#i ncl ude “db. h”
int main()
{
Dbptr db, dbassoc, dbarrival, dbsite ;
int n ;
doubl e arrival _time, delta ;
char sta[25], phase[10] ;
Tbl *sortkeys ;
if ( dbopen ( “denp”, “r+”, &b ) < 0)
die( 0, “Can't opentableknet.origin.”) ;
db = dbl ookup ( db, 0, “origin”, 0, 0) ;
db = dbsubset ( db, “orid == 645", 0 ) ;
dbassoc = dbl ookup ( db, 0, “assoc”, 0, 0) ;
db = dbjoin ( db, dbassoc, 0, 0, 0, 0, 0) ;
0

dbarrival = dbl ookup ( db, O, “arrival”, 0, O
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)

db = dbjoin ( db, dbarrival, 0, 0, O, O,
dbsite = dbl ookup ( db, 0, “site”, O,
db = dbjoin ( db, dbsite, 0, 0, O, O,
sortkeys = strthl (“arrival.tinme”, 0
db = dbsort ( db, sortkeys, 0, 0 ) ;
dbquery ( db, dbRECORD_COUNT, &n ) ;
for ( db.record = 0 ; db.record < n ;
db.record++ ) {
dbgetv ( db, O,
“sta”, sta,
“arrival .time”, &arrival _tine,
“assoc.delta”, &delta,
“assoc. phase”, phase,
0);
printf ( “%5s %7.3lf %40.3If %2s\n",
sta, arrival _time, delta, phase) ;

}

return O;

}

The output from this program is the same as the shell and tcl versions, with some
minor differences in the number of significant digits printed, and the number of
blanks between columns.

Disregarding the syntactical differences because of the different languages, the sig-
nificant difference between thisand the tcl version isthe extraargumentsto dbjoin.
These extra, optional arguments provide some added flexibility, allowing you to
specify the join keys explicitly, and possibly returning alist of records which don’t
join. In most cases, you'll set these extra arguments to zero, but refer to the man
page for more information about them. Another difference is the way the sort keys
are specified to dbsort; the keys are packed into alist, and thislist is passed to
dbsort. Both of these differences derive from the ability in tcl to have avariable
argument list with defaults.

The FORTRAN interface

The FORTRAN interfaceisas similar to the c interface as was practical. The names
are the same, but routines which return database pointers are changed to subrou-
tines with an extra argument added for the return values. Possibly all the routines
should have been changed to subroutines, since the rest return integers, and have to
be declared in the include file, since their names don't start with the right letters (i-
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n). It seems to be impossible to get the FORTRAN compiler to shut up about these
unused “variables’ if you never call them.

Here's the solution in fortran:
#include “db.i”
i nteger db(4), dbt(4)
real *8 tine, arrtine, delta
character*15 sta, phase
i f (dbopen(“demo”,“r+",db ) .I1t. 0)
* call die ( 0, “Can’t open database” )

call dbl ookup( db, db, “", “origin”, “”, “" )

cal|l dbsubset ( db, db, “orid == 645", "“ )
call dblookup ( dbt, db, “", “assoc”, “", “" )
call dbjoin( db, db, dbt, 0, 0, 0, 0, “” )
call dblookup ( dbt, db, “”, “arrival”, “", “" )
call dbjoin( db, db, dbt, 0, 0, 0, 0, “” )
call dblookup ( dbt, db, “", “site”, “", “" )
call dbjoin( db, db, dbt, 0, 0, 0, 0, “” )
call strtbl (keys, “arrival.time”, 0)
call dbsort ( db, db, keys, 0, “" )
call dbquery ( db, dbRECORD COUNT, n )
do i=0, n-1

db(4) =

ierr = dbgetv ( db, O,
*“sta”, sta,

*“arrival .tinme”, arrtine,
*“assoc.delta”, delta

*“assoc. phase”, phase

*0 )
wite (*,10) sta, arrtine, delta, phase

10 format ( al0, f17.3, x, f10.3, x, a3 )

end do

end
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The result from this program differs from the ¢ version programs only in the num-
ber of spaces between fields.

Summary

The example problem is quite simple, of course, but shows the use of the primary
operations from several interfaces. It did not address, however, the issues of modi-
fying afield (dbputv), adding arecord (dbaddv), or creating a new database by
copying the various records from aview into a new table (dbunjoin). There are man
pages for these routines, and the calls follow the general outline of the calls used
above: dbputv and dbaddv are quite similar to dbgetv. dbquery has many more
codes than dbRECORD_COUNT used above; some codes return character strings,
lists or associative arrays. Almost any information which can be read from the
schema file may also be obtained from dbquery with the proper code; dbhelp
exploits this to make it easy to explore a schema

There are detailed man pages for all the c interface library cals; the man pages for
the other interfaces are a bit more skimpy. To see other calls which might be of
interest consult the manual pages.

In the examples above, very little error checking was performed. Real programs
should take more care.

The programs described above may be found in the antelope distribution in the
directory $ANTEL OPE/example/datascope. You'll aso find aMakefile there which
can be used to produce the executables. The Makefileisfairly simple:

BI N= xc xf xperl xsh xtcl

| dl i bs=$( DBLI BS)

i ncl ude $( ANTELOPEMAKE)

To learn how it works, please consult the Antelope Software Development Tutorial.
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CHAPTER 7

Datascope Utilities

There are anumber of specialized programs that add functionality to Datascope.
This chapter introduces the utilities; refer to the man pagesfor detailed information.

dbverify

provides overall consistency checks on a database. It uses the range expressions
from the schemafile to check that each field has alegal value, and it can be used
to perform other simple consistency checks on a database, for instance, check-
ing to see that tablesjoin properly. Many of these additional tests are config-
urable in a parameter file, so you may add your own special tests.

dbcheck

checks each line (record) of each filein a database for the correct length. Datas-
cope requires that files which represent tables be composed of lines which all
have the same length. If you edit these files with a text editor, it is easy to intro-
duce errors by adding or deleting a blank, or converting several blanks to a tab.
dbcheck looks for problems like this.
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dbdiff

compares two databases, with output resembling that of sdiff. Comparing data-
bases is difficult, and dbdiff does not do a complete job, but is very useful in
some situations regardless.

dbdoc

prepares thl/troff style documentation directly from the schema. This can be
useful for generating hardcopy which is more readable than the schema. For
interactive use, dbhelp is more convenient.

dbset

simplifies global changes across multiple tables. For instance, you might want
to change a station name, say from AAK to AKA, in every table. dbset makesthis

easy.

dbfixids

Theidfieldsin adatabase typically have no intrinsic meaning; they are arbitrary
integers which provide asimple key to atable, and are often used to join two
tables. Nevertheless, it is sometimes useful to renumber these ids. This must be
done carefully, since aparticular id may be present in several tables, and all the
ids must be changed in a consistent manner.

dbcrunch

Because views and indexes refer directly to a record number, many programs
(like dbe) do not usually delete records immediately; instead, all fieldsin a
record are set to the null value: marked for later removal. dbcrunch removes
such null records from a database or table.

dbnextid

When anew record is added to certain tables, aunique id must be generated. As
explained previously, these new ids are generally found by consulting the lastid
table, which saves the value of the previously largest integer used, and then
using the next larger integer. (If the lastid table is not present, Datascope |ooks
through the entire table which defines the id in question, and creates a lastid
table). dbnextid provides command line access to this function.
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dbcp

Just asit’s useful to copy afile, it's often convenient to create anew copy of a
database, either to modify it, or to prevent it from being modified. dbcp copiesa
database to anew location. It can also be used to create a descriptor file refer-
encing the original database, or to copy a single database table.

dbremark

The CSS database has a special remark table which may be used to add a com-
ment to particular records of selected tables. dbremark provides a method of
printing or adding a comment at the command line.

dbaddv

isacommand line program for adding records to adatabase. It has an interactive
mode, or can add a single record directly from the command line, or multiple
records by reading from stdin.

dbcalc

allows expressions to be evaluated against a single record of atable or view.
Thisis most useful for testing the syntax of the expression.

dbconvert

isageneral purpose tool for converting from one schemato another. It's a bit
slow, but can be very useful when your first attempt at a schemaleft out some
important fields or made some fields too small. You can create your new
schema (with dbdesign) and then use dbconvert to convert any old databases to
the new schema.

dbdesign

isa GUI program which simplifies the process of creating new schemafiles. It
can aso be used to edit old schemas, or to create schema files which extend an
existing schema.
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dbinfer

isan ad hoc program which reads a single fixed field length record and creates a
schemafilefor a corresponding table, using the whitespace to definefields. This
may be useful asafirst cut at the eventual schemafile.

dbdestroy

removes all the tables of a database; with an option, it will also remove all the
external files (like waveform files).
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